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STM32L4 technical training

Digital Filter for Sigma Delta Modulator (DFSDM)

Hands-on session
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DFSDM Lab

connection of single microphone and collect PCM data
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MEMS microphone connection to DFSDM

() O bJ e Ctlve Figure 4. MP34D-\I;3; -M electrical connections (Top view)
* Learn how to connect MEMS microphone to i
DFSDM in STM32CubeMX —DIOI—
- Learn how to configure DFSDM to convert () oo
PDM to PCM signal e 1 o
* How to Generate Code in STM32CubeMX LR 1 Lo § %3
and use HAL functions | | :
5' —
° Goal Ground ring o GAMS04081409205C

m

« Configure DFSDM peripheral in order to
collect PDM data and convert them into PCM
format.
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MP34DTO1 microphone connection

STM32L476RG-Discovery
« STM32F476RG-Discovery is equipped with one MP34DTO01 microphone

connected to pins:

« PE7 (DFSDM channel2)
 PE9 (DFSDM clock out)

* It requires an external clock in range 1MHz to 3.25M

for proper operation.
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| C70

I 100nF X7R 10% 0402
| [ C69
I1100nF_X7R_10%_0402

sy R7S  R77
3V | GND
[NA] | 0 5% 040
U17
1| vbp LR 2 7
O™ P mmea o
+>— GND  DOUT - AUDIO DIN >
—  MP34DT01

Table 3. Acoustic and electrical characteristics

Hz delivered by DFSDM

Symbal Parameter Test condition Min. Typ. M Max. Unit
Clock | Input clock frequency 3! 1 24 3.25 MHz
Ton Turn-on time ¢! Gua!ranteed by 10 ms
design
Top Operating temperature 40 +85 °c
range
Low level logic _
VlOL inpUUUUtpUt voltage |DUT =1mA -03 035)(Vdd \"
Vioy | High level logic lout = 1 MA 0.65xVdd Vdd+0.3 |V
10H | inputfoutput voltage out ' :
1. Typical specifications are not guaranteed.
2. Input clock in static mode.
Duty cycle: min = 40% max = 60%. ]

B

4. Time from the first clock edge to valid output data.



Selection of the system parameters

* The digital audio output from the microphone is coded in PDM (Pulse
Density Modulation) and is connected to PE7. When CLK = 0 (PE9) ,
the audio PDM signal is sent on PE7.

* Let’s select the following parameters of our system:
« DFSDM clock: 80MHz (system clock)

« Microphone input clock: 2MHz FCM16 bit PDM 1 bit
« Output sampling frequency: 8kHz ’l H W \ﬂ
* Resolution of the output signal: 24bits (signed)




* Create project in STM32CubeMX

* Menu > File > New Project
« Select STM32L4 -> STM32L4x6 -> LQFP100 package -> STM32L476VGTX

» Select DFSDM1.:

« Select “PDM/SPI Input from ch2 and internal clock” option for Channel2
« Select CKOUT to enable clock connection from MCU to microphone
« Change default DFSDM1_CKOUT pin (PC2) to alternative PE9
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STM32CubeMX

clock configuration

* Go to Clock Configuration tab and configure system clock (HCLK) and
DFSDM to 80MHz using HSI 16MHz oscillator and PLL

Pinoutl Clock Configuration | konfiguration | Power Consumption Caleulator|

RTC/LCD Source Mux -
HSE HSE_RTC |
B N
L To Power (MHz)
. | LSE
32,768 LSE —bv To RTC [KHz) “ HCLK to AHB bus, core,

” memory and DMA (MHz)

1-1000 KHz L5I
[= ] > (i) [ 2 Jro coreex sysem smer (v
= | Enable G55 - FCLK Cortex clock (MHz)
- 3z To IWDG (KHz) APEL Prescaler
pCLkl
System Clock Mux = 1 - e »| 0 |APBI peripheral clocks (MHz)
MSI RC T

- APB:I Timer clocks (MHz)
SYSCLK (MHz) AHE Prescaler HOLK (MHz) APE2 Prasczler
K2
B e & > (1 v e [ = |Ape2 peripheral docks (1Hz)

Input frequency

Y

J

; 12|

PLL Source Mux BD MHz max ,—|
MST | = x1 > APBZ timer clocks (MHz)
—l(]
‘_[ USART1 Clock Mux
M

ol [T X1 w Enable G35 R ¥

_ ’ | SYSCLK

Input frequency =N ok —D-TD SDMMC1 (MHz) ook
CLK48 Clock M USART 2 Clock M
. I Y
PLLSATICH POLKL [
PLL SYSOLK Ll 4
PG —
i3 Smm— &4 To RNG (MHz) HSI - 0 o USART2 {MHz)
. 2 T ] | [ |
HSI 16 Sal? EXT LsE
(MHz) MCO . - 12 | DFSDM1 Clock Mux SWPMI1 Clock Mux
PLLCLK PCLK2Z \\ : PCLK1 -
- — —* Q) —|2)
| sysok o
.:::‘::::. - LSCO Source Mux Syscik o DFSDM1 (MHz) Hel D SWPMI1 (MHz)

MSI — () —

- /')’ L
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STM32CubeMX
Configure DFSDM
» Go to Configuration tab and select DFSDM peripheral

|| Pinout | Clock Configuration| Configuration | Power Consumption Calculator |
onfiguration -
-MiddleWares i
E| “ FATFS
. [] user-defined
E| “ FREERTOS

. "] Enabled
=}-Peripherals

[} % CRC
- [] Activated

. Channel 2
- mode:PDM/SPT ir oma 1= Drcoas
CKOUT: Set Q"‘

Middlewares

11

=% IWDG GPIO —%,,
v ] Activated

=% RNG NVIC Ty,
- [7] Activated

=% SYS RCCSY o

Debug:Serial Wire
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STM32CubeMX

configuration of the DFSDM input channel

- Select Channel2 tab (as the
microphone is connected to
this input channel)

« Set SPI with rising edge in Type
field

 Select Internal SPI clock

* Do not configure offset and bit shift,
neither analog watchdog

* Press Apply to confirm the
configuration

Lys
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% DFSDM1 Configuration

il

= Filter 1

|  <7Filter2 |

o/ Filter 3 | «/ Qutput Clock

o/ Channel 2 | «/ User Constants |

«/ NVIC Settings | «/ DMA Settings | « GPIO Settings

Configure the below parameters :

Search :| Search (CriF)

s e

Offset
Right Bit Shift
Analog watchdog parameters

=l Channel 2 parameters |
SPIwith rising edge -
Spi Clock Internal SPI clock

]
0x00

Type

Type_spi_CH2
Parameter Description:
SPI modes.

o

-

Restore Default ]

Apply ] ’ Ok ] ’ Cancel




-+ Select Output Clock tab

» Select: Source for output clock is
system clock (80MHz)

» To have 2MHz clock signal for the
microphone we need to set a divider
to 40 (as 80MHz/2MHz=40)

* Press Apply to confirm the
configuration

Lys
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STM32CubeMX

configuration of the DFSDM output clock

% DFSDM1 Configuration

il

« Channel 2 | o7 User Constants | 7 NVIC Settings | </ DMA Settj

< Output Clock

Filtero |  <’Fiter1 | </Fiter2 | </ Filter3
Configure the below parameters :
Search :| Search (Crtl+F) | ¥ &
=l Output Clock parameters
Selection Source for ouput clock is system clock
Divider 40
Divider -
Divider must be between 2 and 256.
Parameter Description:
Output clock divider. N

’ Restore Default ] [ Apply ] ’ Ok

| | cancel |




STM32CubeMX

configuration of the DFSDM filter — part 1/2

- Select FilterO (can be different one)

« Select Channel 2 in regular channel
selection field

e Set continuous mode
« Select software trigger

 Configure Filter parameters

« Sinc order set to Sinc 3 filter type

« Oversampling (Fosr) set to 250 (to have
output sampling rate 8kHz from input 2MHz)

* losr setto 1 (we will not use it)

* Press Apply to confirm settings

Lys

% DFSDM1 Configuration

il

| o7 channel2 | o/ User Constants | o NVIC Settings | < DMA Settings | </ GPIO Settings
o/ Filter 0 /Filter1 | </Filter2 | </ Filter 3 «/ Output Clock
Configure the below parameters :
Search :| Search (Cril+F) - &
[=l regular channel selection
regular channel selection :Channel 2 -
Continuous Mode Continuous Mode
Trigger to start reqular conversion Software trigger
Fast Mode Disable
Dma Mode Disable i
injected channel selection
|| |= Filter parameters n
Sinc Order Sinc 3 filter type i
Fosr 250
losr 1
| regular channel selection -
Filter_regChannel_FILO
|| Parameter Description: i I
reqular channel selection.

life.augmented

‘ ’ Restore Default ]




STM32CubeMX

configuration of the DMA for DFSDM
» Select DMA Settings tab

|+ DFSDM1 Configuration = 3% )
® CIle Add bUtton o Fitero | «fFiter1 | <PFiter2 | <CFitera | «/ Output Clock

«/ Channel 2 | o/ User Constants | < NVIC Settings | </ DMA Settings | 7 GPIO Settings
* SeIeCt DFSDM]‘—FLTO from DMA DMA Request Channel Direction Priority

requ est DFSDM1_FLTO DMA1 Channel 4 Peripheral To Memory  Low

e Setincrementation on Memory side
« Select Word Data Width for both sides I| I

» Select Circular mode
Add Delete |
. DMA Request Settings
* Press Apply to confirm __
Configuration Mode |Circular v Increment Address ]
Data Width word v | Word v
r Restore Default Apply ] ’ Ok ] ’ Cancel

v/ =
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STM32CubeMX

configuration of the DFSDM filter — part 2/2

* Once DMA channel is

configured we can come back ,
to F|Itero Set'“ngS and » DFSDML1 Configuration —

o/ channel2 | <7 User Constants | 7 NVIC Settings | </ DMA Settings | « GPIO Settings
perform tWO more Steps: . ;:f? Fili:rt;l q;?:nten | </Fiter2 | </Filters | «/ Output Clock
onfigure the below parameters :
* Select Fast Mode: Enable Search 1| 5earch () s
¢ SeleCt Dma MOde Enable : regmarrzhgaur:zflci:l:r:::lugelectic-n Channel 2
I Continuous Mode Continuous Mode
Trigger to start reqular conversion Software trigger
. Fast Mod Enabl
- Press OK to confirm the I s ode Z
injected channel selection
Changes [=I Filter parameters
Sinc Order Sinc 3 filter type
Fosr 250
. . losr 1
- DFSM peripheral is now fully
configured
K” Restore Default Apply ] ’ Ok ] ’ Cancel
life.augmented = -




STM32CubeMX

| | | Project generation
* Now we set the project detalls for generation

« Menu > Project > Project Settings | Project setings ==

Praject | Code Generator | Advanced Settings

« Set the project name

Project Settings
* Project location e

Project Location

° Type Of tOOICha|n C:\_Work\DFSDM_MIC

Toolchain Folder Location
C:\_Work\DFSDM_MIC\L4_MIC_DFSDM

* Now we can Generate Code <] 2 onerat or s

\

* Menu > Project > Generate Code nker Setings |

" Toolchain / IDE ] I

Minimum Heap Size 0x200
Minimum Stack Size 0x400

Mcu and Firmware Package
Mcu Reference
STM32L476VGTx

Firmware Package Name and Version
STM32Cube FW_L4 V1.6.0

Use Default Firmware Location
C:/_Work/_CubeMX/STM32Cube_FW_L4_V1.6.0 Browse

Ly -

] ’ Cancel
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» After successful code generation by STM32CubeMX this is the right
time to import it into SW4STM32 toolchain for further processing



Modifying the code

data declaration and DFSDM start - main.c file

Tasks:

1. Declare the size of the buffer: 1024 words

2. Declare data buffer for DFSDM to store PCM data (32bit signed values)

3. Start DFSDM peripheral in DMA mode for regular conversion for configured channel and its assigned
filter to store AUDIO_BUF number of PCM samples into RecBuff buffer

/* USER CODE BEGIN PV */

/* Private variables —-———————— * /
#define AUDIO BUF 1024

int32_t RecBuff [AUDIO_BUF] ;

/* USER CODE END PV */

/* USER CODE BEGIN 2 */
HAL DFSDM FilterRegularStart DMA (&¢hdfsdml filterO, (int32 t *)RecBuff, AUDIO BUF);
/* USER CODE END 2 */

Lys
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* Now we can compile the code and run the debug session
 As a result we should monitor RecBuff[] table content.

* We can copy the content of this table to a selected PC application for
further analysis



Example of the final result

- An example of measurement of input acoustic signal which was a sine

wave f=600Hz A RecBuff
(5 140000
Q

é\q 120000
S
@O
A 100000
O

o .&Q 80000
G\

Qs 60000

S 40000

20000
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- DMA is taking data from DFSDM_FLTXRDATAR register (there is
separate register for each filter)

* The 24bits PCM data are located on bits 8-32.

« We should shift right the buffer data by 8 bits to get valid acoustic
samples

* To do it In the proper timing we need to synchronize with DMA status
flags (half transfer complete and transfer complete)

IS7;
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DFSDM Lab extension

further processing of the PCM data (DMA transfers management)
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- We will continue with our previous lab on DFSDM

* Now we will configure and use interrupt callbacks raised by DMA
transferring data from DFSDM

» The goal of this part is to perform some additional postprocessing of the
PCM data to have valuable acoustic samples.

Lys
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Modifying the code

postprocessing of the PCM data - main.c file 1/2

Tasks:
1. Declare buffer for post processed PCM data (same size like RecBuff[])
2. Implement callback functions for DMA Half transfer and DMA transfer complete interrupts

/* USER CODE BEGIN PV */

/* Private variables —-——-—--—--—--—--— - */
int 1=0;
int32 t PlayBuff [AUDIO BUF];

uint32 t DmaRecHalfBuffCplt
uint32 t DmaRecBuffCplt

/* USER CODE BEGIN 4 */
void HAL DFSDM FilterRegConvHalfCpltCallback (DFSDM Filter HandleTypeDef *hdfsdm filter)

{
DmaRecHalfBuffCplt = 1;

}

void HAL DFSDM FilterRegConvCpltCallback (DFSDM Filter HandleTypeDef *hdfsdm filter)
{
DmaRecBuffCplt = 1;

}
/* USER CODE END 4 */




Modifying the code

postprocessing of the PCM data - main.c file 2/2

Tasks:
3. Perform postprocessing of the PCM data on completed part of the buffer

/* USER CODE BEGIN 3 */
if (DmaRecHalfBuffCplt == 1) //processing of the first half of the buffer
{
/* Store values on Play buff */
for(i = 0; 1 < AUDIO_BUF/Z; i++)

PlayBuff[i] = RecBuff[i] >> 8; //example of PCM data postprocessing
DmaRecHalfBuffCplt = 0;
}
if (DmaRecBuffCplt == 1) //processing of the second half of the buffer

{
/* Store values on Play buff */

for(i = AUDIO_BUF/Z; i< AUDIO BUF; i++)
PlayBuff[i] = RecBuff[i] >> 8; //example of PCM data postprocessing
DmaRecBuffCplt = 0;

}

Lys
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Example of the final result

- An example of measurement of input acoustic signal which was a sine
wave f=600Hz
PlayBuff

AR AAN DAL

00000

00000

00000



Further reading

* AN4427 — Gasket design for optimal acoustic performance in MEMS microphones
* AN4426 — Tutorial for MEMS microphones

« MP34DT01-M datasheet

* WWW.st.com/mems



http://www.st.com/mems

[§ @sT_world

WwWw.st.com/mcu



http://www.st.com/stm32l4

